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Thank you very much for purchasing FANUC Robot. 
Before using the Robot, be sure to read the "FANUC Robot SAFETY HANDBOOK (B-80687EN)" 
and understand the content. 
 
 • No part of this manual may be reproduced in any form. 
 • The appearance and specifications of this product are subject to change without notice. 
 
The products in this manual are controlled based on Japan's “Foreign Exchange and 
Foreign Trade Law". The export from Japan may be subject to an export license by the 
government of Japan. Further, re-export to another country may be subject to the license 
of the government of the country from where the product is re-exported. Furthermore, the 
product may also be controlled by re-export regulations of the United States government. 
Should you wish to export or re-export these products, please contact FANUC for advice. 
  
In this manual, we endeavor to include all pertinent matters. There are, however, a very 
large number of operations that must not or cannot be performed, and if the manual 
contained them all, it would be enormous in volume. It is, therefore, requested to assume 
that any operations that are not explicitly described as being possible are "not possible". 
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SAFETY PRECAUTIONS 
This chapter must be read before using the robot. 
 
For detailed functions of the robot operation, read the relevant operator's manual to understand fully its 
specification. 
 
For the safety of the operator and the system, follow all safety precautions when operating a robot and its 
peripheral equipment installed in a work cell. 
For safe use of FANUC robots, you must read and follow the instructions in “FANUC Robot SAFETY 
HANDBOOK (B-80687EN)”. 
 

1 DEFINITION OF USER 
The personnel can be classified as follows. 
 
Operator: 
• Turns the robot controller power on/off 
• Starts the robot program from operator panel 
 
Programmer or Teaching operator: 
• Operates the robot 
• Teaches the robot inside the safety fence 
 
Maintenance engineer: 
• Operates the robot 
• Teaches the robot inside the safety fence 
• Maintenance (repair, adjustment, replacement) 
 
- Operator is not allowed to work in the safety fence. 
- Programmer/Teaching operator and maintenance engineer is allowed to work in the safety fence.  

Works carried out in the safety fence include transportation, installation, teaching, adjustment, and 
maintenance.  

- To work inside the safety fence, the person must be trained on proper robot operation. 
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Table 1 lists the work outside the safety fence. In this table, the symbol “” means the work allowed to 
be carried out by the worker. 
 

Table 1 List of work outside the fence 

 Operator Programmer or 
Teaching operator 

Maintenance 
engineer 

Turn power ON/OFF to Robot controller    
Select operating mode (AUTO, T1, T2)    
Select remote/local mode    
Select robot program with teach pendant    
Select robot program with external device    
Start robot program with operator’s panel    
Start robot program with teach pendant    
Reset alarm with operator’s panel    
Reset alarm with teach pendant    
Set data on teach pendant    
Teaching with teach pendant    
Emergency stop with operator’s panel    
Emergency stop with teach pendant    
Maintain for operator’s panel    
Maintain for teach pendant    

 
In the robot operating, programming and maintenance, the operator, programmer/teaching operator and 
maintenance engineer take care of their safety using at least the following safety protectors. 
 
• Use clothes, uniform, overall adequate for the work 
• Safety shoes 
• Helmet 
 

2 DEFINITION OF SAFETY NOTATIONS 
To ensure the safety of users and prevent damage to the machine, this manual indicates each precaution 
on safety with "WARNING" or "CAUTION" according to its severity. Supplementary information is 
indicated by "NOTE".  Read the contents of each "WARNING", "CAUTION" and "NOTE" before 
using the robot. 
 

Symbol Definitions 
 

 WARNING Used if hazard resulting in the death or serious injury of the user will be expected to 
occur if he or she fails to follow the approved procedure. 

 

 CAUTION 
Used if a hazard resulting in the minor or moderate injury of the user, or equipment 
damage may be expected to occur if he or she fails to follow the approved 
procedure. 

NOTE Used if a supplementary explanation not related to any of WARNING and CAUTION 
is to be indicated. 

 
• Check this manual thoroughly, and keep it handy for the future reference. 
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1 PREFACE 
Robot Initial Setup function is the function to enter some settings for robot initial setup on personal 
computer (PC), and load that settings to Robot controller. Robot Initial Setup function consists the 
following 2 parts. 
 
• FANUC ROBOGUIDE  Robot integration setup tool (A08B-9410-J804) 

This is the software on PC to enter some settings for robot initial setup. In this manual, this function is 
called “Robot Integration Setup Tool”. 

 
• R-30iA/R-30iA Mate controller  Initial Setting Load function (A05B-2500-J980) 

This is the function in R-30iA/R-30iA Mate controller to load the setting entered on PC. 
In order to use this function, it is required that teach pendant of Robot controller is iPendant. 
 

• R-30iB/R-30iB Mate/R-30iB Plus/R-30iB Mate Plus controller  Initial Setup Interface function 
(A05B-2600-J947) 
This is the function in R-30iB/R-30iB Mate/R-30iB Plus/R-30iB Mate Plus controller to load the 
setting entered on PC. 
 

There is the following option for FANUC ROBOGUIDE Robot Integration Setup Tool. 
 
• FANUC ROBOGUIDE Servo gun integration setup tool (A08B-9410-J805) 

This is the software on PC to enter some settings for servo gun setup in addition to robot initial setup. 
In this manual, this function is called “Servo Gun Integration Setup Tool”. 
 

In order to load settings created by Servo Gun Integration Setup Tool, it is required the following option 
in R-30iA controller.  
 
• R-30iA controller Servo gun setup package (A05B-2500-J979) 
 
In order to load settings created by Servo Gun Integration Setup Tool, it is required the following option 
in R-30iB/R-30iB Plus controller.  
 
• R-30iB/R-30iB Plus controller Servo gun setup Interface package (A05B-2600-J890) 
 
In this chapter, the functional overview of Robot Initial Setup function and the system requirement are 
described.  
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1.1 FUNCTIONAL OVERVIEW 
This software is used to enter several settings for robot initial setup. The settings entered on PC are filed 
and loaded to Robot controller. In this PC tool, the following settings can be entered on PC. 
 
<Function setting> 

• Tool Frame 
• User Frame 
• Jog Frame 
• Frame Number 
• Air Pressure Abnormal Detection 
• Hand Broken Detection 
• Reference Position 
• Soft Float 
• Payload 
• System Configuration 
• Register 
• Register Comment 
• Position Register Comment 
• Macro 
• User Alarm 
 
<I/O setting> 
• I/O Configuration 
• I/O Comment 
• I/O Polarity, Complementary 

 
The setting data entered on PC tool is output to a file. Then, the file is transferred to Robot controller by 
the memory card or the communication. Setting data entered on PC are read by “Initial Setting Load 
function” when R-30iA/R-30iA Mate controller, by “Initial Setup Interface” when R-30iB/R-30iB 
Mate/R-30iB Plus/R-30iB Mate Plus. 
 

NOTE 
 About soft Float setting, Robot Integration Setup Tool does not support pushout 

Soft Float. 
 

NOTE 
 Soft float function is option. In case that soft float option is not available in 

controller, the setting for soft float is not loaded.  
 

NOTE 
 For detail of each setting data, please refer to operator’s manual of controller. 

 
In case that Servo Gun Integration Setup Tool option is installed in PC and Servo Gun setup package is 
installed in R-30iA controller or Servo Gun setup interface package installed in R-30iB/R-30iB Plus 
controller, the following settings for servo gun can be set by this function.  
 
• Servo Gun function setting 
• Servo Gun schedule setting 
• Servo Gun axis setting  
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Robot Integration Setup Tool and Servo Gun Integration Setup Tool have the following features. 
 
1. Input/Output function of setting file. 
 The setting items entered on PC can be output as the setting file (PRM file and DT file). You can do 

setting operation easily by loading output file to Robot controller. And you can confirm and edit the 
contents of the setting file that has been output from PC or Robot controller.  

 
2. Save setting data to the file described by XML format. 
 In PC tool, you can save the setting data to the file described XML format. This XML file has all 

data entered on PC. You can reload and edit this XML file by this PC tool. This XML file is not the 
file to load to Robot controller. 

 
3. CSV file transformation 
 Reading CSV file which describes setting contents by each tools, and transform to setting file (PRM, 

DT) or save file (XML). 
 

1.2 SYSTEM REQUIREMENT 
Robot Integration Setup Tool and Servo Gun Integration Setup Tool can be executed on the following 
operating system. 
• Microsoft Windows 7® 
• Microsoft Windows 10® 
 
This manual does not describe the basic, common operations of Windows®. If you use Windows® for the 
first time, please read the manual for Windows® first to learn its basic operations. 
 
System requirements of PC for Robot Integration Setup Tool and Servo Gun Integration Setup Tool are as 
follows. 
 

Table 1.2 System requirements 

Operating System 
Windows 7® (Japanese, English) 
Windows 10® (Japanese, English) 

CPU Pentium 4 (3.0GHz or over recommended) 

Memory 
Minimum: 256MB of system memory 
Recommended: Over 1GB  

Hard Disk 30 MB of free hard disk space 

Display 1024 x 768 screen resolution 

 
Note that Microsoft® Virtual PC and VMware® Workstation are not supported. 
 
* Windows, Windows 7, Windows 10 are registered trademark of Microsoft in United States. 
* VMware is trademarks or registered trademarks of VMware, Inc. in the United States and/or various 

jurisdictions. 
* Pentium® is registered trademark of Intel in United States. 
* VS-FlexGrid Pro 8.0J Copyright (C) 2001-2007 ComponentOne LLC. 
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2 INSTALL AND UNINSTALL 
The procedure to install and uninstall this software is as follows. 
 

2.1 INSTALLATION REQUIREMENTS 

• Robot Integration Setup Tool V7.70 (or later) installer cannot replace its V1.0.0 installation. Please 
uninstall Robot Integration Setup Tool V1.0.0 prior to V7.70 installation. (Refer to 2.3.2 Uninstall) 

• Servo Gun Integration Setup Tool requires exactly the same version of Robot Integration Setup Tool 
is installed on the target PC. 

 

2.2 ROBOT INTEGRATION SETUP TOOL INSTALL 
Insert the CD-ROM and the installer launched automatically. (If not, launch setup.exe in the CD-ROM.) 
The installer might show different screens depending on installed components. Please follow the guidance 
on the screen.  
 

2.2.1 Requisites 
(1) Before you install, you must have the pre-requisite software installed. If all pre-requisites are 

installed, please skip this section and follow the steps from 2.2.2 “Robot Integration Setup Tool”. 
Following screen will be displayed. Follow the navigation to proceed. 
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(2) Pre-requisites to be installed are shown. Click "Install". 
 

 
 

(3) This might requires reboot your PC. 
 

 
 

(4) Click "Yes" to proceed. 
 

 
 

(5) After power-cycle, the setup will automatically continue. If not, launch setup.exe in the CD-ROM. 
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2.2.2 Robot Integration Setup Tool 
(1) If all pre-requisites are installed, the following screen will be displayed. 

 

 
 

 If the previous version, V1.0.0, of Robot Integration Setup Tool exists on the target PC, the 
following dialog will pop up. Please uninstall this previous version first. 

 

 
 

(2) Click "Next>" to proceed.  
 

 
 

 Select destination location if you want. If any of FANUC PC products are installed, this destination 
is fixed and cannot be changed. In this case the following screen is showed instead. 
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(3) Click "Next>". Confirmation screen is showed. 
 

 
 

(4) Click "Next>" to proceed. 
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(5) The following screen is showed at the end of installation. 
 

 
 

(6) Click "Finish". 
 

2.2.3 Uninstall 
To uninstall this product, use "Add or Remove Programs" in Control Panel and select "FANUC 
ROBOGUIDE Robot Integration Setup". 
 

2.3 ROBOT INTEGRATION SETUP TOOL (V1.0.0) 

2.3.1 Install 
Installation of Robot Integration Setup Tool V1.0.0 will be described here. 
 
(1) Insert the CD-ROM. The following screen will be displayed. Install this software according to the 

instruction on the screen. (It is possible to display the different screen by OS or the setting on PC.) 
 

 
 
(2) Click ‘Next’ button in this screen. 
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(3) Click ‘Install’ button to start the software install. After a while, software install finishes, and the 

following screen will be displayed. 

 
 
(4) Click ‘Finish’ button to finish the software install operation. 
 

2.3.2 Uninstall 
Uninstall of Robot integration setup tool (Version 1.0.0) is done by following procedure. 
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(1) Run Setup.exe in CD-ROM then the following screen will be displayed.  
Uninstall the software according to the instruction on the screen. 

 

 
 
(2) Click ‘Next’ button. The following screen will be displayed. 
 

 
 
(3) Check ‘Remove’ and click ‘Next’ Button in this screen. If you selected ‘Modify”, you can change 

installing program function. If you selected ‘Repair’, error in program will be repaired. 
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(4) Click ‘Remove’ button to start the software uninstall. 
 

 
 
(5) After the following screen will be displayed, click ‘Finish’ button to finish the software uninstall 

operation. 
 

 
 

2.4 SERVO GUN INTEGRATION SETUP TOOL 

2.4.1 Install 
Servo Gun Integration Setup Tool requires the Robot Integration Setup Tool is installed. 
 
(1) Insert the CD-ROM and launch setup.exe inside. Please follow the navigation. (Screen may be 

different depending on your OS or configuration) 
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 If the exactly same version of Robot Integration Setup Tool is not found on the target PC, the 
following dialog will popup. Install the Robot Integration Setup Tool first. 

 

 
 

(2) Click "Next>". The destination will be displayed. 
 

 
 

(3) Click "Next>". Confirmation screen is showed. 
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(4) Click "Next>" to proceed. 
 

 
 

(5) The following screen is showed at the end of installation. 
 

 
 

(6) Click "Finish". 
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2.4.2 Uninstall 
To uninstall this product, use "Add or Remove Programs" in Control Panel and select "FANUC 
ROBOGUIDE Servo Gun Integration Setup". 
 

2.5 SERVO GUN INTEGRATION SETUP TOOL (V1.0.0) 

2.5.1 Install 
To Install Servo Gun Integration Setup Tool, Servo Gun Integration Setup Tool option 
(A08B-9410-J805) is needed, and it is required to install Robot Integration Setup Tool in advance. 
 
(1) Run Setup.exe for Servo Gun Integration Setup Tool in CD ROM. 
 The following screen will be displayed. Install this software according to the instruction on the 

screen. 
 (It is possible to display the different screen by OS or the setting on PC.) 
 

 
 
(2) Click ‘Next’ button in this screen. 

 
 

(3) Click ‘Install’ button to start the software install. After a while, software install finishes, and the 
following screen will be displayed. 
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(4) Click ‘Finish’ button to finish the software install operation. 
 

2.5.2 Uninstall 
(1) Run Setup.exe for Servo Gun Integration Setup Tool in CD ROM. 

The following screen will be displayed. Uninstall the software according to the instruction on the 
screen. 

 
 
(2) Click ‘Next’ button. The following screen will be displayed. 
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(3) Check ‘Remove’ and click ‘Next’ Button in this screen. If you selected ‘Modify”, you can change 
installing program function. If you selected ‘Repair’, error in program will be repaired. 

 
 

 
 
(4) Click ‘Remove’ button to start the software uninstall. 
 

 
 
(5) After the following screen will be displayed, click ‘Finish’ button to finish the software uninstall 

operation. 
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2.6 LICENSING 
You need registration to use this product. Please open license manager ([Start] -> Fanuc Robotics -> 
License Manager) and send displayed Part number, software code 1 and software code2 to FANUC sales. 
You will get registration key REG1 and REG2, then input them in the license screen to register. 
 
You can use this product for 30 days without registration. 
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3 ROBOT INITIAL SETUP OPERATION 
In this chapter, the operations for Robot Integration Setup Tool on PC are described. 
 

3.1 OPERATION FLOW 
The operation flow for robot initial setting tool is as follows. 
 
1. In the main screen, set the configuration of the setting robot cell. 
 In Robot Integration Setup Tool, set the data with respect to each robot cell. In the main screen, set 

the cell name and the configuration of devices comprising a robot cell. For details, refer to 3.2 
MAIN SCREEN. 

2. In the detail screen, set the data for each machine in the cell. In case that the machine type is Robot 
controller, there are ‘Function setting’ and ‘I/O setting’ in the detail screen. In case that the machine 
type is another, there is only ‘I/O setting’ in the detail screen. For details, refer to 3.3 DETAIL 
SCREEN.  

3. Output the settings to the initial setting file on the PC tool. 
 Output the setting to the initial setting file when machine type is Robot controller in order to load the 

setting to Robot controller. The output operation of the setting data can be executed in the main 
screen. For details, refer to 3.2.4.1 Output initial setting file.  

 

3.2 MAIN SCREEN 
In the main screen, set the following data of the setting up robot cell. 
 

Table 3.2 Setup Items in Main Screen 
Setting items Contents 

RobotCell 
Set the robot cell name, because the output file of setting contents is handled by the 
cell name. 

RobotCell Comment Set the comment about the robot cell. This setting can be omitted. 

Machines List 
Set the machines comprising the robot cell. Set the machine type for each machine. 
In case that the machine type is Robot Controller, set the number of group. 

 
The basic operations in the main screen are as follows. 
 
1. Add line to the table by ‘Add’ button (6), then set the machine name (9) and select the machine type 

(10).  
2. In case that the Machine Type is Robot Controller, select the number of the Group (11) from list. 
3. Click the ‘Detail’ button (8) to display the detail setting screen (3.3 DETAIL SCREEN) for the 

selected line. 
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Fig. 3.2 Main screen 

 
Followings are the descriptions for each part in the main screen. 
 
(1) ‘File’ menu 

• New    All machines in the table are deleted and new robot cell is created. 
• Open    Saved file is opened. Refer to “3.2.1 Open file”.  
• OverWrite  Setting data are over writed. Refer to “3.2.2 Overwrite”.  
• Save    Setting data are saved to other file. Refer to “3.2.3 Save”.  
• Output  Setting data are output to initial setting file etc. Refer to “3.2.4  

     Output”.  
• Input    Initial setting file is loaded. Refer to “3.2.5 Input”.  
• Convert CSV  This is not supported in English. This is supported only in Japanese. 
• Import Standard Setting Registered standard setting are loaded. Refer to “3.2.7 Import  

     Standard setting”. 
• Servo Gun  Servo Gun Integration Setup Tool is started. Refer to “3.2.8 Start  
       Servo Gun Integration Setup Tool”.  
• End    Robot Integration Setup Tool will be finished. 

(2) ‘Setup’ menu 
• Initial Setting File Directory  Directory to output initial setting file is designated. Refer to  
       “3.2.9 Initial Setting File Directory”.  
• Work File Directory  Directory to output work file is designated. Refer to “3.2.10  
       Work File Directory”.  
• Change Language    The representation language is changed. Refer to “3.2.11 

      Change Language”.  
• Equipment Type Edit  Equipment type is added and removed. Refer to “3.2.12  
        Equipment Type Edit.  

(3) ‘Help’ menu 
• Version  Software Version is displayed. Refer to “3.2.13 Version information”. 
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(4) ‘RobotCell Name’ edit box   
• Input Robot Cell Name 

(5) ‘RobotCell Comment’ edit box 
• Input the comment for Robot Cell 

(6) ‘Add’ button 
• Add machine in Robot Cell. 

(7) ‘Delete’ button 
• Remove the selected machine in Robot Cell. 

(8) ‘Detail’ button 
• Display the detail screen for the selected machine. 

(9) ‘Machine Name’  
• Input the machine name. 

(10) ‘Machine Type’ 
• Select machine type from ‘Robot Controller’, ‘PLC’, ‘Machine Tool’, ‘Jig’, and ‘Hand’. 

Machine type can be added and removed in Equipment Type Edit screen in Setup menu. 
(11) ‘Group’ 

• In case that the machine type is Robot controller, set the number of group. According to the 
number of group, settable group number in detail screen is changed. Max 5 groups are settable. 
In case that the machine type is another, it is not need to set the number of group. Group is 
displayed as “****”. 

 

3.2.1 Open File 
1. Select ‘Open’ in File menu. (1) 
2. ‘Open’ window will be displayed.  
3. Select saved XML file for Robot Integration Setup Tool. (2) 
4. Click ‘Open’ button to load and to deploy the selected file. (3) 

 

 
 

Fig. 3.2.1 Open 
 

3.2.2 Overwrite 
1. Select ‘OverWrite’ in File menu. (1) 
2. In case that the saved file exists, the dialog to confirm overwriting the existing file is displayed. (2) 

In case that the saved file is not exist, the dialog to confirm creating new file is displayed. (3) 
3. Save the setting data to the file. 
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Fig. 3.2.2 Overwrite 

 

3.2.3 Save 
1. Select ‘Save’ in File menu. (1) 
2. ‘Save As’ window will be displayed. 
3. Input new file name to ‘File name’. (2) 
4. Click ‘Save’ button. (3) 

 

 
 

Fig. 3.2.3 Save 
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3.2.4 Output 
There are 3 types as the output file, “Initialization File Output”, “Work File Output” and “Both Output”. 
• Initialization file is the ASCII format file. This file is used to load the data set on PC tool to Robot 

controller.  
• Work file is the CSV format file. This file is used to refer the I/O setting in order to describe the 

document of the work instruction or the operation manual for the system. 
• When selecting “Both Output”, both initialization file and work file are output. 

  
3.2.4.1 Output initial setting file 

1. Select ‘Output’ in File menu and select ‘Initialization File Output’ in the Output menu. (1) 
2. Initial setting file is output to the directory designated in 3.2.9 Initial Setting File Directory. (2)  

 

 
 

Fig. 3.2.4.1 (a) Initial setting file output 
 

The initial setting file is handled with ‘Robot Cell Name’ set in main screen. In case that the file named 
same Robot Cell Name is already exists, the initial setting file is overwritten. In this case, the following 
dialog is displayed. If you want not to overwrite the file, click ‘No’ to abort output operation, and change 
the Robot Cell Name in main menu and do initial setting file output procedure once again. 
 

 
 

Fig. 3.2.4.1 (b) Initialization file output (Overwrite) 
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3.2.4.2 Output work file 
1. Select ‘Output’ in File menu and select ‘Work File Output’ in the Output menu. (1) 
2. Work File is output to the directory designated in 3.2.10 Work File Directory. (2)  

 

 
 

Fig. 3.2.4.2 Work file output 
 

3.2.4.3 Both output 
1. Select ‘Output’ in File menu and select ‘Both Output’ in the Output menu. 
2. Both “3.2.4.1 Output initial setting file” and “3.2.4.2 Output work file” are executed. 
 

3.2.5 Input 
“Initialization File Reading” and “Work File Reading” exists in file input. 
・ “Initialization File Reading” is used to read controller setting output fie. See “5.2.4 Store Current 
 Setting of Robot Controller” 
・ “Work File Reading” is used to see content of work file which is output by PC. 
 

3.2.5.1 Input initial setting file 
1. Select ‘Input’ in File menu and select ‘Initialization File Reading’ in Input menu. (1) 
2. ‘Open’ window will be displayed. (2) 
3. Select Initial Setting File (.prm). 
4. Initial setting file is read. (3) 
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Fig. 3.2.5.1 Initial setting file input 
 

3.2.5.2 Input work file 
1. Select ‘Input’ in File menu and select ‘Work File Reading’ in Input menu. (1) 
2. ‘Open’ window will be displayed. (2) 
3. Select work file that you want to input, and click ‘Open’ button. 
4. ‘Confirmation of Work File’ screen will be displayed. (3) 
5. When you want to input another work file, click ‘Select File’ button. (4) 
6. ‘Open’ window (2) will be displayed again. Select another work file to input. 
7. If ‘Close’ button is clicked, ‘Confirmation of Work File’ screen will be closed. (5) 
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Fig. 3.2.5.2 Work file reading 
 

3.2.6 CSV File Conversion 
Import from CSV file is not supported in English. 
 

3.2.7 Import Standard Setting 
The standard I/O settings, by which robot connect to CNC machine tool by PMC function used in 
Machine tool connection function, are registered in Robot Integration Setup Tool. In similar configuration 
cell, integration setup is accomplished by only doing necessary setting after loading registered default 
setting. Following settings are registered in advance. 
 

Table 3.2.7 Standard setting registered in advance 
RobotCell Name RobotCell Comment Content 

Standard 1 MTOOL Connection (One CNC) I/O default setting for Machine Tool Connection Function. 
Robot connects with 1 CNC by FL-Net. 

Standard 2 MTOOL Connection (Four CNC) I/O default setting for Machine Tool Connection Function. 
Robot connects with 4 CNC by FL-Net. 
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1. Select ‘Import Standard Setting’ in File menu. (1) 
2. ‘Select standard setting’ window will be displayed. (2) 
3. Select the standard setting that you want to import, and click ‘OK’ button.(3) 
4. Registered file will be loaded. 
 

 
 

Fig. 3.2.7 Import Standard Setting 
 

3.2.8 Start Servo Gun Integration Setup Tool 
In case that Servo Gun Integration Setup Tool (A08B-9410-J805) is installed in PC, you can start Servo 
Gun Integration Setup Tool in file menu. 
 
1. Select ‘Servo Gun’ in File menu. (1) 
2. Servo Gun Integration Setup Tool will be started. (2) 
 (In case that the Servo Gun Integration Setup Tool is not installed or its license is not exist, ‘Servo 

Gun’ cannot be selected.) 
 
See “4. SERVO GUN SETUP OPERATION (OPTION)” for Servo Gun Integration Setup Tool. 
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Fig. 3.2.8 Start Servo Gun Integration Setup Tool  
 

3.2.9 Initial Setting File Directory 
1. Select ‘Initial Setting File Directory’ in Setup menu. (1) 
2. The dialog to input directory to save the initial setting file will be displayed.  
3. Input path in the input box (2) or select path in ‘Browse for Folder’ (5) displayed by (3) button. 
4. Click ‘OK’ button. (4) 

 

 
 

Fig. 3.2.9 Initial Setting file directory assignment 
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3.2.10 Work File Directory 
1. Select ‘Work File Directory’ in Setup menu. (1) 
2. The dialog to input directory to save the work file will be displayed.  
3. Input path in the input box (2) or select path in ‘Browse for Folder’ (5) displayed by (3) button. 
4. Click ‘OK’ button. (4) 

 

 
 

Fig. 3.2.10 Work file directory assignment 
 

3.2.11 Change Language 
1. Select ‘Change Language’ in Setup menu. (1) 
2. ‘Change Language’ dialog will be displayed. (2)  
3. Check the language by radio button and click ‘OK’ button. (3)  
4. The language in the screen is changed to the selected language. (4) 
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Fig. 3.2.11 Change language 
 

3.2.12 Equipment Type Edit 
1. Select ‘Equipment Type Edit’ in Setup menu. (1) 
2. In order to add new machine type, input the machine type in ‘Add Machine Type (Japanese)’ input 

box (3) in Japanese, then input the machine type in ‘Add Machine Type (English)’ input box (4) in 
English. Then, Click ‘Add’ button (5). 

3. In order to delete the machine type, select the machine type in the list box (7), then click ‘Delete’ 
button (6). 

4. The result of editing the machine type is reflected in the list box (7). 
5. Click ‘OK’ button (8) to store the result of editing. If ‘Cancel’ (9) button is clicked, the content of 

editing is revoked. 
 
 It is possible to add new machine type by either Japanese name or English name. Non input 

language is displayed as ‘****’. 
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Fig. 3.2.12 Equipment type edit 

 

3.2.13 Version Information 
Select ‘Version’ in Help menu to display ‘Version information’ screen. 
 

 
 

Fig. 3.2.13 Version information 
 
 
 



B-83054EN/04  3. ROBOT INITIAL SETUP OPERATION 

- 31 - 

3.3 DETAIL SCREEN 
Detail screen can set each device settings. Detail screen varies depending on Machine type. In case that 
Machine type is Robot Controller, the detail screen consists of Function setting and I/O setting. In the 
case of other Machine type, there is only I/O setting. And, the setting items in I/O setting vary depending 
on Machine type.  
 
The basic operations in detail screen are as follows. 
 
1. Select the setting item in the Setting Item Selection Tree (1). 
2. Input data in Data Input Field (4). 
3. Click ‘OK’ button (12). 

 

 
Fig. 3.3 Detail screen 

 
Followings are the description for each part in the detail screen. 
 
(1) Setting Item Selection Tree 

• The tree of the current opening robot’s setting items is displayed. 
• The setting data is displayed in Data input field (4) by selecting an item in the tree. 

(2) ‘File’ menu  
• Save   The data are saved to the file. Refer to “3.2.2 Overwrite”. 

(3) ‘Edit’ menu 
• Cut   The data in the selected cell in editable column in grid is cut. 
• Copy   The data in the selected cell in editable column in grid is copied. 
• Paste   The data in the clipboard by Cut or Copy is pasted. 
• Delete The data in the selected cell in editable column in grid is deleted. 

(4) Data input Field 
• The data in the setting item selected in left Tree are displayed. Input the data in this field. 

(5) Check Box 
• The data checked in the check box are output to the initial setting file. 
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• Uncheck the check box of the data that you want not to load to Robot controller. 
(6) ‘Check All’ button 

• All check boxes in the selected screen are checked. 
(7) ‘Uncheck All’ button 

• All check boxes in the selected screen are unchecked. 
(8) ‘String Search’ button 

• The specified string is searched. Refer to “3.3.5 String Search Window”.  
(9) (10) ‘Item Name’ column 

• This column displays item name. This column cannot be changed. 
(11) ‘Value’ column 

• Set the data of ‘Item Name’. 
(12) ‘OK’ button 

• When ‘OK’ button is clicked, not only displayed data but also all detail settings are saved and 
detail screen will be finished. 

(13) ‘Cancel’ button 
• When ‘Cancel’ button is clicked, the data changed and set after opening detail screen or after 

saving are canceled and detail screen will be finished. 
 

3.3.1 In case that Machine Type is Robot Controller 
Followings are the description for Data Input Field in case that Machine type is Robot Controller. When 
Robot Controller, the detail screen consists of Function setting and I/O setting. 
 

NOTE 
About setting data for each item, see controller manual. 

 
Function Setting 

 
3.3.1.1 Tool frame, User frame 

Input X, Y, Z, W, P, R. 
 

 
Fig. 3.3.1.1 (a) Tool Frame 
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Fig. 3.3.1.1 (b) User Frame 

 

3.3.1.2 Active frame 
Input active frame number for user frame, tool frame, and jog frame. 
       

 
Fig. 3.3.1.2 Active Frame 

 
3.3.1.3 Air pressure abnormal, Hand broken 

Select Enable or Disable in the pull down list in Value column. 
In the item Air Pressure Abnormal, select TRUE if you want to enable the detection of Air Pressure 
Abnormal for selected group. 
In the item Hand Broken, select TRUE if you want to enable the detection of Hand Broken. 

 

 
Fig. 3.3.1.3 (a) Air pressure 

 

 
Fig. 3.3.1.3 (b) Hand broken 
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3.3.1.4 Reference position 
Set data for the reference position. 
 

 
Fig. 3.3.1.4 Reference position 

 

3.3.1.5 Jog frame 
Input the jog frame data X, Y, Z, and W, P, R. 

 

 
Fig. 3.3.1.5 Jog frame 
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3.3.1.6 Soft Float 
Input the data for soft float function. Setting items vary depending on the setting of “Soft float type”. 
When “Soft float type” is changed, the setting items are changed automatically. 

 
NOTE 

• Robot Integration Setup Tool does not support setting of pushout Soft Float. 
• Soft float is option. In case that soft float option is not available in controller, 

the setting for soft float is not loaded. 
 

 
Fig. 3.3.1.6 (a) Soft Float (Cartesian) 

 

 
Fig. 3.3.1.6 (b) Soft Float (Joint) 
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3.3.1.7 Payload setting 
Input the data for Payload. 
 

 
Fig. 3.3.1.7 Payload setting 

 

3.3.1.8 System configuration 
This sets important setting for system configuration. 
 

 
Fig. 3.3.1.8 System configuration 

 
Following items in the System Configuration cannot be set by this function. 

• WJNT for default motion all change 
• Reset CHAIN FAILURE detection 
• UOP auto assignment 
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3.3.1.9 Register, Position register 
In register, input value and comment. In position register setting, input comment for position register. 
 

 
Fig. 3.3.1.9 (a) Register 

 

 
Fig. 3.3.1.9 (b) Position register 
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3.3.1.10 Macro 
Set Macro Name, Program Name, Assign Type, and Assign Number for Macro command. 

 

 
Fig. 3.3.1.10 Macro 

 
The macro that is set as the system level macro (e.g. GETDATA) in Robot controller cannot modify by 
this function. 
 

3.3.1.11 User alarm 
About User Alarm Severity severity, select the severity from ‘WARN’, ‘STOP.L’, ‘ABORT.L’, 
‘STOP.G’, and ‘ABORT.G’ by pull down list. 
About setting of the message, input string data.  
 

 
Fig. 3.3.1.11 User alarm 
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3.3.1.12 Miscellaneous 
Set the following two items TRUE (Enable) or FALSE (Disable).  
• Output BATALM signal when the backup battery for the pulse coder is abnormal. 
• Recover override when safety fence is closed. 

 

 
Fig. 3.3.1.12 Miscellaneous Setting 

 
I/O setting 

In I/O setting, set ‘Connect Machine Setting’ at first. Then, set ‘Input Setting’ and ‘Output Setting’ 
according to the number of input signals and output signals set in ‘Connect Machine Setting’. In case that 
‘Connect Machine Setting’ is not set, ‘Input Setting’ and ‘Output Setting’ cannot be set. 
 

3.3.1.13 Connect machine setting 
1. Select the connected machine name by pull down list in ‘Connect Machine’ (1). Only the machine 

name set in main screen can be set in this item. 
2. Select ‘I/O equipment’ by pull down list (2), and set ‘Input Point’ (3), ‘Output Point’ (4), ‘Input 

Start Physical No.’ (5), ‘Output Start Physical No.’ (6), ‘Rack No.’ (7), ‘Slot No.’ (8), and ‘Connect 
Method’ (9). 

3. To set ‘Peripheral I/O’, double-click the ‘Peripheral I/O’ cell (10) then ‘*’ is set. To cancel 
Peripheral I/O, double click ‘*’ cell. ‘Peripheral I/O’ can be set in only one ‘I/O module’. 

4. If you want not to output I/O setting to the initial setting file, uncheck the check box ‘File Out’ (11). 
 

 

 
Fig. 3.3.1.13 Connect machine setting 

 
3.3.1.14 Input setting 

1. ‘I/O Type’ (1) and ‘I/O Number’ (2) are set automatically, but they can be changed. Select ‘I/O 
Type’ (1) by pull down list (UI/DI), and change ‘I/O number’ if required. 

2. Input ‘I/O Name’ (3). 
3. Input comment (4). 
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4. Select ‘Polarity’ (5) from ‘Normal’, ‘Inverse’ by pull down list.  
 In case that the signal type is UI, the polarity of the signal cannot be set. 
5. When Group Input is used, set the assigning GI number (6). 
 The same GI number is set only to the serial signals.  
6. ‘Rack No.’, ‘Slot No.’, Connect Machine’, and ‘Connect Machine Signal Name’ (7) are set 

automatically by setting of Connect Machine Setting and setting in the connected machine. 
 

 
Fig. 3.3.1.14 Input setting 

 
3.3.1.15 Output setting 

1. ‘I/O Type’ (1) and ‘I/O Number’ (2) are set automatically but they can be changed. Select ‘I/O 
Type’ (1) by pull down list (UO/DO), and change ‘I/O number’ if required. 

2. Input ‘I/O Name’ (3). 
3. Input ‘Comment’ (4). 
4. Select ‘Polarity’ (5) from ‘Normal’, ‘Inverse’ by pull down list. 
 In case that the signal type is UO, this cannot be set. 
5. Select ‘Complementary’ (6) from ‘FALSE’, ‘TRUE’ by pull down list. 
6. When Group Output is used, set the group signal (7). 
 The same GO number is set only to the serial signals.  
7. ‘Rack No.’, ‘Slot No.’, ‘Connect Machine’, and ‘Connect Machine Signal Name’ (8) are set 

automatically by setting of Connect Machine Setting and setting in the connected machine. 
 

 
Fig. 3.3.1.15 Output setting 
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3.3.2 In case that Machine Type is PLC 
Followings are the description for Data Input Field in case that the machine type is PLC. In case that 
Machine type is PLC, there is only I/O setting in detail screen. 
 

I/O Setting 
In I/O setting, set ‘Connect Machine Setting’ at first. Then, set ‘Input Setting’ and ‘Output Setting’ 
according to the number of input signals and output signals set in ‘Connect Machine Setting’. In case that 
‘Connect Machine Setting’ is not set, ‘Input Setting’ and ‘Output Setting’ cannot be set. 
 

3.3.2.1 Connect machine setting 
1. Select the connected machine name by pull down list in ‘Connect Machine’ (1). Only the machine 

name set in main screen can be set in this item. 
2. Select ‘I/O Equipment’ (2) by pull down list, and set ‘Input Point’ (3), ‘Output Point’ (4), ‘Input 

Start Physical No.’ (5), ‘Output Start Physical No.’ (6), ‘Rack No.’ (7), ‘Slot No.’ (8), and ‘Connect 
Method’ (9). 

3. In case that the machine type is PLC, ‘Peripheral I/O’ (10) cannot be set. This is settable only when 
robot controller. 

 

 
Fig. 3.3.2.1 Connection machine setting 

 
3.3.2.2 Input setting, Output setting 

1. Input ‘I/O name’ (1). 
2. Input the description of this signal to ‘Contents’ (2). 
3. ‘I/O Equipment’, ‘Rack No.’, ‘Slot No.’, Connect Machine’, and ‘Connect Machine Signal Name’ 

(3) are set automatically by setting of Connect Machine Setting and setting in the connected 
machine. 
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Fig. 3.3.2.2 (a) Input setting 

 

 
Fig. 3.3.2.2 (b) Output setting 

 

3.3.3 In case that Machine Type is Machine Tool, Jig, Hand 
Followings are the description for Data Input Field in case that the machine type is Machine Tool or Jig 
or Hand. In case that Machine type is Machine Tool or Jig or Hand, there is only I/O setting in detail 
screen. In case that machine type is new machine type added in Equipment Type Edit, the setting items 
are same as Machine Tool, Jig and Hand.  

 
I/O Setting 

In I/O setting, set ‘Connect Machine Setting’ at first. Then, set ‘Input Setting’ and ‘Output Setting’ 
according to the number of input signals and output signals set in ‘Connect Machine Setting’. In case that 
‘Connect Machine Setting’ is not set, ‘Input Setting’ and ‘Output Setting’ cannot be set. 
 

3.3.3.1 Connect machine setting 
1. Select the connected machine name by pull down list in ‘Connect Machine’ (1). Only the machine 

name set in main screen can be set in this item. 
2. Select ‘I/O Equipment’ (2) by pull down list, and set ‘Input Point’ (3), ‘Output Point’ (4), ‘Input 

Start Physical No.’ (5), ‘Output Start Physical No.’ (6) ‘Rack No.’ (7), ‘Slot No.’ (8), and ‘Connect 
Method’ (9).  

3. In case that the machine type is Machine Tool or Jig or Hand, ‘Peripheral I/O’ (10) cannot be set. 
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Fig. 3.3.3.1 Connection machine setting 

 

3.3.3.2 Input setting, Output setting 
1. Input the signal address to ‘Address’ (1). 
2. Input the ‘I/O Name’ (2). 
3. ‘Connect Machine’, and ‘Connect Machine Signal Name’ (3) are set by Connect Machine Setting 

and setting in the connected machine automatically. 
 

 
Fig. 3.3.3.2 (a) Input setting 

 

 
Fig. 3.3.3.2 (b) Output setting 
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3.3.4 Check Box 
 In Function setting of detail screen, all setting items have check box (1). When the initial setting file 
output operation is done, the items checked in its check box are output. 
 
When the each setting screen is displayed first, all check boxes are checked. In order to uncheck all check 
boxes, click ‘Uncheck All’ button (2). In order to check all check boxes in the screen, click ‘Check All’ 
button (3).  

 

 
Fig. 3.3.4 (a) Check box (Function Setting) 

 
 In I/O setting of detail screen, there is only one check box in Connect Machine Setting screen. When this 
check box (1) is unchecked, all I/O settings are not output to the initial setting file   
 

 
Fig. 3.3.4 (b) Check box (I/O Setting) 

 

3.3.5 String Search Window 
When ‘String Search’ button is clicked, the String Search window is displayed. 
 
1. Click ‘String Search’ button (1). 
2. Input the search string to the input box (2) in String Search window. 
3. Click ‘OK’ button (3). 
4. As the result of string search, the cell that includes the search string is colored yellow. (4) 
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Fig. 3.3.5 String Search 
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4 SERVO GUN SETUP OPERATION 
(OPTION) 

This chapter explains about operation of Servo Gun Integration Setup Tool.  
 

4.1 OPERATION FLOW FOR SERVO GUN SETUP 
Setup is performed by the following procedure. 
 
1. Set up servo gun on main screen. 
 This software set up servo gun per kind. Hardware parameter and function setting of servo gun are 

specified on main screen. Refer to 4.2 MAIN SCREEN for more detail.  
2. Specify detail parameter on detail screen for each setting.  
 Refer to 4.6 DETAIL SCREEN for more detail.  
3. Output setup data to setup file to load into robot controller. 
 Output operation is performed on main screen. Refer to 4.3.1 Output.  

 

4.2 MAIN SCREEN 

When Servo Gun Integration Setup Tool is started up via Robot integration setup tool, then the 
following screen is displayed. 

 

 
 

Fig. 4.2 Main screen 
 

(1) (2) (3) 

(4) (5) 

(6) 

(7) 
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The followings are items on this screen.  

 
(1) “File” menu 

•  “New”   It creates new servo gun setup data.  
•  “Open”   It opens XML file that saves servo gun setup data. 
•  “Save”   It saves servo gun setup data into new XML file.  
•  “OverWrite” It saves servo gun setup data into XML file that is opened with overwriting.  
•  “Output”  It outputs setup data on the screen into setup file which is loaded to controller.  
•  “Input”   It loads setup file that is created on controller. 
•  “Convert CSV” This cannot be used in English. This can be used only in Japanese. 
•  “End”   It ends Servo Gun Integration Setup Tool.  

(2) “SetUp” menu  
•  “Set Up File Address” It specifies address to output setup file. 
•  “Change Language”  It changes language of Servo Gun Integration Setup Tool. 
•  “Unit”     It changes unit of pressure force.           
•  “Motor”     It sets up to add a kind of motor. 
•  “Motor File address” It specifies address of motor file that includes new motor.  

(3) “Help” menu 
•  “Version”  It shows software version.   

(4) “Servo Gun Name” edit box 
•  Write servo gun name to set up.  

(5) “Comment” edit box 
•  Write comment about servo gun name to be set up.  

(6) “Servo gun setting” list 
•  “Servo Gun Function Setting” It performs setting of servo gun function. 
•  “Servo Gun Schedule Setting” It performs setting of servo gun schedule.  
•  “Gun axis Setting”   It performs setting of servo gun axis.  

(7) Detail screen 
•  It displays detail items of selected setting category and can do setting. 
 

4.3 FILE MENU 
Via File menu, it can perform file operation of Servo Gun Integration Setup Tool.  
The following basic operation is same as Robot Integration Setup Tool.  

• “New”  
• “Open” 
• “Save”  
• “OverWrite”  
• “End” 

This section explains about particular file operation of Servo Gun Integration Setup Tool.  
 

4.3.1 Output 
Via Output menu, setup file is output to load into robot controller.  
1. Select “File”-“Set Up File Output”(1). 
2. Setup files are output into SVGNPRMS folder on path that is specified by Set Up File Address. 

SVGNPRMS folder is created automatically, if it is not existed. If SVGNPRMS folder already exists, 
files are output additionally to the folder. 

3. Setup files are created for each servo gun name. If an existed named servo gun has been output, a 
message whether the setup data is overwritten or not is prompted (2). 
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NOTE 
In SVGNPRMS folder, setup files SVGNxxxx.prm, SVGNxxxx.dt are created. (xxxx 
is a number of created order.) 
Also, SVGNLIST.csv, which is made simultaneously, indicates name of servo gun 
that is saved in SVGNxxxx.prm. 
Do not edit these files. 

 
NOTE 
When it loads setup file to controller, copy SVGNPRMS folder that includes setup 
file to root on memory card. 

 

 
 

Fig. 4.3.1 Output 
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4.3.2 Input 
Setup file SVGN0000.prm that is created in robot controller can be loaded. About how to create 
SVGN0000.prm, refer to 5.2.6 Store Current Setting of Servo Gun to file.  
1 Select ”File”-“Input”-“Set Up File Input”(1) 
2 ”File Open” dialog (2) is displayed. 
3 Select setup file (SVGN0000.prm).  
4 Load setup file (3). 
5 Setup data that is included in load setup file is applied to Servo Gun Integration Setup Tool.  
 

NOTE 
 The servo gun is named as “SVGN000”. Change the servo gun name and do 

setting operation.  
 Servo gun axis setting cannot be loaded. 

 

 
 

Fig. 4.3.2 Set Up File Input 
 

4.3.3 CSV File Conversion 
The data input from CSV file cannot be used in English. This is supported only in Japanese. 
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4.4 SETUP MENU 

4.4.1 Set Up File Address 
1. Select “SetUp”-“Set Up File Address” (1). 
2. ”Output initialize file path” dialog (2) will be displayed.  
3. Enter a path in box (2) or click button (3), then “Browse for folder” dialog (5) will be opened and 

select a path that you want to output.  
4. Click “OK” button (4).  
 

 
 

Fig. 4.4.1 Setting of Set Up File Address 
 

4.4.2 Change Language 
1. Select “SetUp”-“Change Language” (1).  
2. ”Change Language” dialog (2) will be displayed.  
3. Select language via Radio button (3), then click “OK” button. 
4. Language on screen is changed (4). 
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Fig. 4.4.2 Change language 

 

4.4.3 Unit for Pressure Force 
1. Click pressure unit that you want to use via “SetUp”-“Unit”(1) menu. 
2. Pressure unit of max pressure of gun axis setting and Weld Pressure of pressure schedule is changed. 

(2) 
 

 
Fig. 4.4.3 Unit for pressure force 
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4.4.4 Motor Settings 
You can select only general servomotor for servo gun via “Motor type” of servo gun axis setting. 
About special servomotor expect pre-provided servomotor on “Motor type” pull down menu, you have to 
add it in beforehand. Adding special servomotor* allows for you to select it. 
 
*  This product can add servomotor that is supported by Servo gun axes option
（A05B-2500-H869/A05B-2600-H869）on robot controller. 
 
Start up motor setting screen by the following procedure. 
1. Select “SetUp”-“Motor”(1) 
2. “Motor Setting screen” (2) is displayed.  
 

 
Fig. 4.4.4 Motor Setting 

 

4.4.4.1 Motor setting screen 
The following shows motor setting screen. 
 

 
 

Fig. 4.4.4.1 Motor Setting screen 
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(1) Motor list  :  It lists up motors that user add.  
(2) Motor information :  It displays and edits about motor data.  
(3) Register button :   This button registers Motor data on motor information. If the motor name is  
      existed, the data is overwritten. If not, the data is added.  
(4) Delete button :  This button deletes selected motor data on motor list. 
(5) Output button :   This button outputs selected (some) motor(s) data on motor list to XML file. 

 A number of motor can be output to one XML file. 
(6) Read button :   This button loads XML file that include motor data. Also it can load XML  
      file that created by other PC that Servo Gun Integration Setup Tool is  
      installed.  
(7) OK button  :  This button saves setting on motor setting screen, and then returns to servo 

 gun setup tool operation.  
(8) Cancel button :   This button does not save setting on motor setting screen, and then returns to 
      servo gun setup tool operation. 
 

4.4.4.2 Motor addition 
Motor data is added by the following procedure.  
1. Enter motor name on motor information menu. (1)  
 

 
 

Fig. 4.4.4.2 Motor addition 
 
2. Enter motor parameter 1-3 * on motor information menu. (2)  
*   Motor parameters are numbers that is entered to identify Motor size, Motor type (rpm), and Motor 

current in servo gun axes setting on robot controller. The following sample shows setting of αiS8 
4000/80A. 
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Do not enter parameter that servo gun axes option is not supported. 
Please call FANUC, if you have unknown motor parameters. 

3. Click Register button (3).  
4. The named motor is added into motor list (4). 
5. If the same named motor exists in motor list, message whether motor data is overwritten or not (5) is 

prompted.  
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4.4.4.3 Output motor setting file 
It can output added motor setting to XML file. 
 
1. Select motor that you want to output in motor list (1). If some motors exist in the list, any number of 

motors that you want to output can be selected, then output to one XML file.  
2. Click Write button (2) in following figure.  
3. File save dialog (3) is displayed.  
4. Enter file name, then click Save button (4). If same named XML file exists, it can be overwritten.  
 

 
 

Fig. 4.4.4.3 Motor setting file output 
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4.4.4.4 Load motor setting 
It can load motor setting that was created in beforehand, and then can edit.  
 
1. Click Read button (1) on motor setting screen in following figure.  
2. File Open dialog (2) is displayed.  
3. Select motor setting file, then click Open button (3). 
4. Motors that are included in the selected motor setting file are added to motor list (4). 
 

 
 

Fig. 4.4.4.4 Motor setting file load 
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4.4.4.5 Delete motor setting 
It can delete needless motor setting. 
 
1. Select needless motor on motor list in following figure. (1)  
2. Click Delete button (2). 
3. Confirmation prompt is displayed. (3) If yes is selected, the motor will be deleted. 
 
 

 
 

Fig. 4.4.4.5 Motor setting delete 
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4.4.5 Motor File Address 
To select Motor type in “4.6.4 Servo Gun Axis Setting Screen”, specify path of created motor setting file. 
 
1. Select “SetUp”-“Motor File Address”(1) in following figure. 
2. Address screen (2) is displayed. 
3. Specify path of motor setting file that includes motor data to select in Servo Gun Axis Setting 

Screen. 
4. Click file select button (3) to display file select dialog (4). 
5. Click OK button (5) when setting is complete. 
6. Added motor can be selected in Servo Gun axis Setting Screen(6). 
 

 
Fig. 4.4.5 Motor file address setting 
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4.5 HELP 
It shows Software version. 

 
1. Select “Help”-“Version”(1).  
2. “Version Information” screen (2) is displayed. 

 

 
 

Fig. 4.5 Version Information 
 

4.6 DETAIL SCREEN 

4.6.1 Preparation for Setting 
Enter servo gun name within 20 characters. 
 

 
 

Fig. 4.6.1 Servo Gun name and comment input 
 
Setup file cannot be created with existed same servo gun name. 
If using existed same servo gun name, messages whether setup data is updated or not is prompted. 
Enter comment within 10 characters if you need it. 
If you do not enter servo gun comment, servo gun name is applied to comment. 
If servo gun name is over 11 characters and comment is nothing, first 10 characters of servo gun name is 
applied to servo gun comment.  
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4.6.2 Servo Gun Function Setting Screen 
Select “Servo Gun Function setting” on servo gun setting category list, then display the setting items on 
detail screen. These items set up general function of servo gun. 
 

 
Fig. 4.6.2 Servo Gun function setting screen 

(1) It displays setting items.  
(2) It specifies setup parameter.  
(3) It decides whether the data is output or not with check box. Only item that is checked is output to 

setup file. 
(4) It searches text on screen. 
 
NOTE 
 “Close Direction (Robot): Frame number” and “Close Direction (Robot): Direction” 
can be specified for both of robot gun system that robot carries gun and stationary gun 
system that robot handles work panel. 
When a setup file is loaded, select which system is applied. Only setting of the 
selected system is applied. 
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4.6.3 Servo Gun Schedule Setting Screen 
Select “Weld Schedule” or “Distance Schedule” or “Manual Backup Schedule” or “Condition of manual 
pressure part thickness” via “Servo Gun Schedule Setting” on Servo Gun Setting category list, then 
display the setting items on detail screen. 
 
The following example is weld schedule screen. 
 

 
Fig. 4.6.3 Servo Gun schedule setting screen 

 
(1) It adds or deletes each schedule setting line.  
(2) This is a column to set schedule number for each schedule. 
(3) It specifies setting parameter.  
(4) It decides whether data is output or not with check box. Only item that checked is output to setup file. 
(5) It searches text on screen. 
 
Operate weld schedule setting screen with the following. 
• Firstly, enter schedule number that you want to set into schedule number cell. 

Note that pressure schedule number and distance schedule number are limited within 99 and manual 
backup schedule number is limited within 30 and Condition number of manual pressure part thickness 
is limited within 10.  

• Then specifies setting parameter into setting cell in next column or after. 
• If you want to add new schedule, click “Add Row” button. Then new schedule line is added. 
• If you want to delete needless schedule line, select needless schedule number cell, and then click 

“Delete Row” button, then the selected schedule line will be deleted. 
• About other schedule, the above is common. 
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4.6.4 Servo Gun Axis Setting Screen 
Select “Gun axis Setting” on servo gun setting category list, then display the setting items on detail 
screen. 
These items set up servo gun hardware settings. 

 
Fig. 4.6.4 (a) Servo Gun axis setting screen 

(1): It displays setting items name. 
(2): It specifies setup items value. 
(3): It decides whether data is output or not with check box. Servo gun axis setting cannot output 

individual item. 
(4): It searches text on screen. 
 
About setting motor type, select motor name via pull down menu. If there is no motor type that you want 
to select, you need to add the motor type. Refer to 4.4.4 Motor Settings. When the motor type is added, it 
can be selected via pull down menu.  
 

 
 

Fig. 4.6.4 (b) Motor type selection 
 



B-83054EN/04 5. OPERATION TO LOAD SETTING DATA ON ROBOT 

- 63 - 

5 OPERATION TO LOAD SETTING DATA ON 
ROBOT 

The operation to load robot initial setting and servo gun setting input on PC to Robot controller will be 
described. 
 
In Robot controller, the initial setting file is loaded by ‘Initial Setting Load function’ software option 
(A05B-2500-J980) on R-30iA/R-30iA Mate or ‘Initial Setup Interface function’ software option 
(A05B-2600-J947) on R-30iB/R-30iB Mate/R-30iB Plus/R-30iB Mate Plus. Initial Setting Load 
function/Initial Setup Interface function, the current setting in controller can be output to the file with the 
initial setting file format. 
 

In order to execute the Initial Setting Load function in R-30iA/R-30iA Mate 
controller, teach pendant must be iPendant. 

 
In case that the software option ‘Servo gun setup package’ (A05B-2500-J979) on R-30iA or ‘Servo gun 
setup interface package’ (A05B-2600-J890) on R-30iB/R-30iB Plus is installed, it is possible to load the 
setup file created by Servo Gun Integration Setup Tool. 
 

5.1 PREPARATION IN ROBOT CONTROLLER 
The setting file output by Robot Integration Setup Tool is loaded in Initial Setting Load screen in Robot 
controller. You can load the initial setting files into controller with one of following methods. 
• Memory Card Load the initial setting file from the memory card stored the initial setting file. 
• FTP   Load the initial setting file by the FTP communication with PC. 
• USB Memory Load the initial setting file from the USB memory stored the initial setting file. 
 
The setting file output by Servo Gun Integration Setup Tool is loaded in Robot Setting screen in 
controlled start menu. In Robot Setting screen, the setting file is loaded from memory card. 
 
It is possible to load the setting file output by Servo Gun Integration Setup Tool in Initial Setting Load 
screen. In Initial Setting Load screen, the setting file for servo gun can be loaded by “Memory Card”, 
“FTP” or “USB Memory” like the robot initial setting file. However, the servo gun axis setting in the 
servo gun setting can be loaded only in the Robot Setting screen in controlled start menu. 
 

5.1.1 Load form Memory Card 
In order to load the initial setting file output by Robot Integration Setup Tool, copy all subfolders and 
files in the Initial Setting File Directory into a memory card, and insert that memory card into Robot 
controller and do load operation. 
 
In order to load the setting file output by Servo Gun Integration Setup Tool, copy all subfolders and files 
in SVGNPRMS folder in the Set Up File Address into a memory card. Insert that memory card into Robot 
controller and do load operation.  
 

5.1.2 Load with FTP 
Set up Robot controller as an FTP client that is connected to the FTP server on the PC on which ‘Robot 
Integration Setup Tool’ runs. 
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1. Set up PC as an FTP server beforehand. 
2. Set the IP address of Robot controller at ‘SETUP Host Communication’ screen. 
3. Set up parameters to connect the FTP Server on the PC at the ‘SETUP Clients screen’. 
See “3 FTP OPERATION” in “Ethernet Function OPERATOR’S MANUAL (B-82974EN)” for robot 
side detail procedure 
 
With the FTP connection established by aforementioned operation, do loading operation in “Initial 
Setting Load Screen”. 
 

5.1.3 Load from USB Memory Card 
In order to load the initial setting file output by Robot Integration Setup Tool, copy all subfolders and 
files in the output folder into a USB memory, and insert the USB memory into controller and do load 
operation.  
 
In order to load the setting file output by Servo Gun Integration Setup Tool, copy all subfolders and files 
in SVGNPRMS folder in the output folder into a USB memory. Insert the USB memory into controller 
and do load operation.  
 

5.2 PROCEDURE TO LOAD INITIAL SETTING FILE 

5.2.1 Display Initial Setting Load Screen 
Display ‘Initial Setting Load‘ screen by the following operations. 
 
1. Press MENU key, and select ‘Browser’ from menu. 

 

 
Fig. 5.2.1 (a) Browser screen 

 
2. Press F1 [TYPE] key to display menu. 
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Fig. 5.2.1 (b) Browser screen menu 

 
3. Select ‘Init.setup’ in the menu to display ‘Initial Setting Load’ screen. 
 

 
Fig. 5.2.1 (c) Initial setting load screen (1)  

 
 In case that the software option ‘Servo gun setup package’ (A05B-2500-J979)  or ‘Servo gun setup 

interface package’ (A05B-2600-J890) is installed, the screen by which Servo gun setup can load is 
displayed as follows. 

 

 
Fig. 5.2.1 (d) Initial setting load screen (2)  
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5.2.2 Attention about Initial Setting Load Screen 
About display of Initial Setting Load screen, there are some attentions as follows. 
 
1. In case that the software series and version matches one of the followings. 

• Software series 7DA4 all aversion 
• Software series 7DA5 version 09 or before 
• Software series 7DA7 version 01 

 
 Select ‘Init. Setup’ in menu, which is displayed by F1 DISP key, to display Initial Setting Load 

Screen. 
 If the item ‘Init. setup’ does not appear in the F1[TYPE] menu, set the following system variables by 

manual. 
 
 (In case that Servo gun setup package/Servo gun setup interface package is not ordered.) 

System variable Data 
$TX_SCREEN[i].$DESTINASTION ../../frh/ncrobot/nris01.stm 
$TX_SCREEN[i].$SCREEN_NAME Init. setup 

(i: Find the number which is not used in the array of $TX_SCREEN, and set data.) 
 
(In case that Servo gun setup package/Servo gun setup interface package is ordered.) 

System variable Data 
$TX_SCREEN[i].$DESTINASTION ../../frh/ncrobot/nris07.stm 
$TX_SCREEN[i].$SCREEN_NAME Init. setup 

(i: Find the number which is not used in the array of $TX_SCREEN, and set data.) 
 
 To confirm whether Servo gun setup package/Servo gun setup interface package is ordered, check 

whether the item ‘Servo gun setup package J979’ or ‘Servo gun setup interface J890’ exists in the 
screen which can be displayed by the operation [MENU] - [STATUS] - [Version ID] - [Config].   

 
2. In the case of other software series and version. 
 If the item ‘Init. setup’ appears twice in the menu, please clear above system variables.   

 

5.2.3 Loading Robot Initial Setting File 
Load the robot initial setting files as follows. 
 
1. Select ‘Memory card’ or ‘USB disk’ or ‘FTP client’ as an input device. 
 

 
Fig. 5.2.3 (a) Device selection  
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Memory card , USB memory and FTP client tags are shown on the device selection list. To select 
‘FTP Client’, FTP client settings are required in advance. 

 
2. Press ‘Load’ button inside ‘General Setting’ section. 

 
Fig. 5.2.3 (b) Load button 

 
3. Following screen will be displayed. Select the initial setting files. The initial setting files are 

designated by the Cell Name to which the Robot belongs, and by the Robot Name. 

 
Fig. 5.2.3 (c) Cell list button, Robot list button  

 
 Input the Cell Name and Robot Name directly, or select one from cell list and robot list stored in the 

device, then initial setting file is specified. 
 To select the cell name and the robot name, select the cell name in which robot reside, and select 

robot name from the robot list which shows robots reside in the selected cell. With no selection of 
cell, the robot list is not shown. Press ‘Cell List’ button. 

 
Fig. 5.2.3 (d) Cell list 
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 Select a target cell and press ‘Robot List’ button. Robot name list in the cell will be displayed. 
    

 
Fig. 5.2.3 (e) Robot list 

  
 Select a target robot and press ‘Set’ button. Both the cell name and robot name are set. 
    

 
Fig. 5.2.3 (f) Cell name and Robot name input 

 
4. Press ‘Load’ button. Robot controller starts to load the initial setting file. 
    

 
Fig. 5.2.3 (g) Initial setting file reading 

 
5. When Robot controller successfully loads the files, the following screen is displayed. 
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Fig. 5.2.3 (h) Initial setting file read end 

 
NOTE 

Reboot Robot controller definitely to apply the change. 
 

5.2.4 Store Current Setting of Robot Controller to File 
Store the current setting of Robot controller by the following operations. Only “Function setting” is 
stored to file. “I/O setting” is not stored. 
 
1. Select ‘Memory card’ or ‘USB disk’ or ‘FTP Client’ as a target device. 
 To select ‘FTP Client’, FTP client settings are required. 
 

 
Fig. 5.2.4 (a) Device selection 

 
2. Press ‘Create’ button inside ‘General Setting’ section. 
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Fig. 5.2.4 (b) Create button 

 
3. The following screen will be displayed. To store the current setting, select ‘Yes’. 
 

 
Fig. 5.2.4 (c) Initial setting file create 

 
4. When Robot controller successfully stores the setting, Initial Setting Load screen is displayed. 
    

 
Fig. 5.2.4 (d) Initial Setting Load screen 

 
 A subfolder ‘ROBOCEL00’ is created on the target device. This folder contains the following files. 
 

• CELLDATA.TXT (an administrative file) 
• ROBDAT01.PRM (Initial setting files format) 

 You can load this ‘ROBDAT01.PRM’ into Robot Integration Setup Tool with the menu 
‘Initialization File Reading’. In this case, the Robot Name becomes ‘Robot’. 
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NOTE 
Only the setting for Function setting is described in the file created by this 
operation. The setting for I/O setting is not described. 

 

5.2.5 Load Servo Gun Setting File 
If “Servo gun setup package” (A05B-2500-J979) or “Servo gun setup interface package” 
(A05B-2600-J890) option is installed, load servo gun setup files with the following operation. 
 

5.2.5.1 Loading setup file via Robot Maintenance screen 
Servo gun setup files can be loaded via robot maintenance screen in controlled start with the following 
procedure. 
 
1. Start up Controlled Start. 
 Power up with pressing Prev key and Next key , then select Controlled start on configuration menu. 
2. Display robot maintenance screen. 
 Press Menu key, select “9. MAINTENACE ”. 
3. Insert memory card whose root has SVGNPRMS folder including setup files made by servo gun 

integration setup tool to slot on controller. 
 

NOTE 
Do not edit setup files that are created by Servo Gun Integration Setup Tool. 
If setup files are edited, setting process cannot be executed correctly.  
 

4. Move cursor “Servo Gun Axes”(1), then press F5 GunSet (2).  
 Note that F5 GunSet key appears only when Servo gun setup package option is installed. 

 

 
Fig. 5.2.5.1 (a) Robot Maintenance screen 

 
5. The following screen will be displayed. Enter servo gun name within 20 characters. 
 If you want to escape from this screen, enter 0. 
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Fig. 5.2.5.1 (b) Servo Gun name input 

 
Error massage is prompted in the following cases and return to MAINTENANCE screen. 

• Memory card is not inserted correctly. 
• Servo gun name is not correct. 
• There is not setup file of entered servo gun name. 
• There is no correct data in setup file in memory card. 

 
6. Confirmation screen that shows configuration and servo gun name will be displayed. 
 

 
Fig. 5.2.5.1 (c) Servo Gun setting  

If hardware configuration and servo gun name are correct, enter 1. Then servo gun axis setting is 
loaded. 
If you want to cancel setup, enter 0. Then it returns to robot maintenance screen (procedure 4). 
If you want to change hardware configuration, enter 9. Then select item number of configuration that 
you want to change, and change configuration as follows. 

 
NOTE 
In this screen, only amplifier number and brake number can be changed. 
If you want to change FSSB line number or hardware start axis number, change 
the data in manual setup screen via F4 Manual key. 
Note that FSSB line number or hardware start axis number can be change when 
there is no gun axis in the group. 
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 Procedure to change hardware configuration (Ex. Changing brake number) 
1. Enter 9 to select “Change hard config” on setting confirmation screen (1). 
2. Enter 2 to select brake number setting on changing hard config screen (2). 
3. Enter brake number on changing brake number screen (3).  
4. Back to hard changing hard config screen. Enter 0 to finish changing operation (4). 
5. Changed configuration is applied on confirmation screen (5). 

 
 

 
 

Fig. 5.2.5.1 (d) Hardware configuration change 
 

7. When servo gun axis setting is complete, next servo gun other settings is started. 
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Fig. 5.2.5.1 (e) Servo Gun setting 

 

Enter 1 for stationary gun system.  
If not, enter 2 when robot carries gun. 
If you want to quit, enter 0 to return robot maintenance screen (procedure 4). In this case, only servo 
gun axis setting is performed, but servo gun other settings. 
 

8. When all settings are over, it returns to robot maintenance screen. 
 
Procedure to delete servo gun axis 
Perform usual operation to delete axis via manual setting screen with F4 MANUAL.   
 

5.2.5.2 Load servo gun setting file in initial setting load screen 
It is possible to load the Servo gun function setting and Servo gun schedule setting in Initial Setting Load 
screen that is displayed after cold start. However, the servo gun axis setting can be loaded only in the 
Robot Setting screen in controlled start menu. 
 

Table 5.2.5.2 Load the servo gun setting 

Setting Robot Setting screen Initial Setting Load screen 

Servo gun function setting Loadable Loadable 

Servo gun schedule setting Loadable Loadable 

Servo gun axis setting Loadable Not loadable 

 
1. Select ‘Memory card’ or ‘USB disk’ or ‘FTP client’ as an input device. 
 

 
Fig. 5.2.5.2 (a) Device selection 
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 Memory card, USB memory and FTP client tags are shown on the device selection list. To select 
‘FTP Client’, FTP client settings are required. 

 
2. Press ‘Load’ button inside ‘Servo Gun’ section. 
    

 
Fig. 5.2.5.2 (b) Load button 

 
3. Following screen will be displayed. Select the servo gun setting file. Designate which servo gun 

setting file is loaded by the gun name. 
 

 
Fig. 5.2.5.2 (c) Setting file load screen 

 
 Input the Gun Name directly, or select one from the gun list stored in the target device. 
 To see the list of the stored servo gun setting files, press ‘Gun List’. 
    

 
Fig. 5.2.5.2 (d) Gun list screen 
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 Select the target gun by its name and press ‘Set’. The gun name is set. 
    

 
Fig. 5.2.5.2 (e) Gun name input 

 
 In addition, set the following parameters about configuration of the servo gun. 

 
Gun Number: In order to use multiple servo guns with one controller, set the identification number 
of the target gun. When you use only one servo gun with one Robot controller, input ‘1’ definitely. 
 
Pedestal gun: If the target servo gun is a pedestal gun, press ‘Pedestal Gun’ and make the green lamp  
turned on. To cancel the pedestal gun setting, press the button again and make the  lamp turned off. 

 
4. Press ‘Load’. Robot controller starts to load the servo gun setting file. 
    

 
Fig. 5.2.5.2 (f) Setting file reading 

 
5. When Robot controller successfully loads the files, 1st Initial Setting Load screen is displayed. 
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Fig. 5.2.5.2 (g) Completion of load setting file 

 
6. When it fails in loading the files, the error message ‘Reading some system variable failed’ is 

displayed. Refer to ¥Device(MC, etc)¥SVGNPRMS¥SGERROUT.TXT when this message is 
displayed. The system variables that cannot be read are recorded in SGERROUT.TXT. The system 
variables not recorded in SGERROUT.TXT are loaded successfully. 

 

5.2.6 Store Current Setting of Servo Gun to file 
It is possible to store the current setting of the servo gun by the follow operations if ‘Servo gun setup 
package’ (A05B-2500-J979) or ‘Servo gun setup interface package’ (A05B-2600-J890) is ordered. 

 
1. Select an output device. 

 
Fig. 5.2.6 (a) Device selection 

 
 Memory card, USB memory and FTP client tags are shown on the device selection list. To select 

‘FTP Client’, FTP client settings are required in advance. 
 
2. Press ‘Create’ button inside ‘Servo Gun’ section. 
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Fig. 5.2.6 (b) Create button 

 
3. The following screen will be displayed. To store the setting, designate the gun number and select 

‘Exec.’ 
 

 
Fig. 5.2.6 (c) Setting file create 

 
4. When Robot controller successfully stores the setting, 1st Initial Setting Load screen is displayed. 
 

 
Fig. 5.2.6 (d) Completion of making initial setting file 

 
 The following file is created in the subfolder ‘SVGNPRMS’ on the target device in file output. 
 
 SVGN0000.PRM (Servo gun setting file format)  
 
 You can load this ‘SVGN0000.PRM’ into Servo Gun Integration Setup Tool with the menu ‘Setup 

File Input’. In this case, the servo gun name becomes ‘SVGN0000’. 
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